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Installing Cincom Smalltalk

This release of Cincom Smalltalk™ contains complete versions of
VisualWorks® 7.7 and ObjectStudio® 8.2, including object engines,
virtual image, and add-on products. The release contains new
features, as well as many fixes.

The release is distributed on two disk:
* one CD containing VisualWorks 7.7

* one DVD containing ObjectStudio 8.1 and a collection of
Smalltalk Daily podcasts.

System Requirements

ObjectStudio

Installation Guide

ObjectStudio 8.2 runs on these Microsoft Windows platforms
*  Microsoft Windows XP, Vista, 2000, or Server 2003
Disk and Memory Requirements
* 512 MB of memory recommended, minimum
* Apx. 435 MB disk space
* 415 MB in Program Files (cincom/ObjectStudio8.2/)
* 18 MB in the Home directory (ObjectStudio8.2/)

* DVD-ROM drive
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VisualWorks

1-2

VisualWorks 7.7 runs on workstations with the following minimum
system configurations.

Disk and Memory Requirements
* 512 MB of memory recommended, minimum

* Apx. 610 MB disk space for default installation

* Apx. 780 MB disk space for full, single platform installation
e Apx. 1.2 GB disk space for full installation with all platforms
e CD-ROM drive (for installation)

Microsoft Windows

* A PC or compatible with an Intel Pentium compatible processor
*  Windows 2000/Server 2000/XP SP2/Vista/7

HP-UX

e HP 9000 Series 700 workstation

¢ HP-UX Release 11.x

Sun Solaris

e 32-bit requires at least SPARC V7 processor architecture

e 64-bit requires at least SPARC V9 processor architecture

e Solaris 8 (SunOS 5.8) or better

IBM AIX
e AIX workstation with PowerPC processor

e AlXrelease 5.2 (ML 5200-03) and up

Apple Mac 0S X - Aqua
e Mac OS X Tiger (10.4) or Leopard (10.5)

The Mac OS X object engine is now distributed as a universal binary
that will run on either PowerPC or Intel Macintosh computers.

Cincom Smalltalk



Getting Help

Apple Mac 0S X - X11
e Mac OS X Tiger (10.4) or Leopard (10.5)

e X11 libraries for Mac OS X

The Mac OS X object engine is now distributed as a universal binary
that will run on either PowerPC or Intel Macintosh computers.

Linux x86/x86-64
*  32-bit requires a Intel Pentium compatible processor

*  64-bit requires an AMD x86-64 compatible processor
e Linux kernel version 2.4 or later

*  GNU glibc version 2.2 or later

Linux PowerPC
¢ A PowerPC compatible processor

e Linux kernel version 2.4 or later

e GNU glibc version 2.2 or later

Getting Help

Installation Guide

If, after reading this document, you need additional help:

e Commercial licensees can contact Cincom Technical Support.
Cincom provides help on product installation. For other issues,
send email to helpna@cincom.com.

* Non-commercial licensees can get help on-line from the
resources listed in the VisualWorks Application Developer’s
Guide.

Before contacting Technical Support, please be prepared to provide
the following information:

* The release number, which is displayed when you start
VisualWorks.

* Any modifications (patch files, auxiliary code, or examples)
distributed by Cincom that you have imported into the image.
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Installing Cincom Smalltalk

e The complete error message and stack trace, if an error notifier is
the symptom of the problem. To do so, use Copy Stack, or select
and copy the text in the error window, and paste the text into a file
that you can send to Technical Support.

e The hardware platform, operating system, and other system
information you are using.

You can contact Technical Support using any of the following

methods:

E-mail Send questions about VisualWorks
to:helpna@cincom.com.

Web Visit: http://supportweb.cincom.com and choose the
link to Support.

Telephone Within North America, call Cincom Technical Support

at (800) 727-3525.0utside North America, contact
the local authorized reseller of Cincom products.
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Installing VisualWorks

VisualWorks can be installed either from CD or by download from the
Cincom Smalltalk website (non-commercial only).

The VisualWorks installer is the recommended option for most users.
To begin, see Running the VisualWorks Installer.

Note: The installer does not set up personal work directories,
but we strongly recommend that you do so. You can do this by
saving your working image to a work directory. See Save Image
for a suggested procedure.

Experienced VisualWorks users may prefer simply to extract files
from the CD or website. Configuration details, such as setting paths
and file associations, must be performed manually. For details, see
Extracting VisualWorks from Downloaded Files.

Running the VisualWorks Installer

Installation Guide

The VisualWorks Installer can be run from either the Cincom website
(non-commercial version only) or a distribution CD (commercial or
non-commercial versions).

¢ To install from the web, visit the Cincom Smalltalk Download site.
Select Cincom Smalltalk, and then select to install the Net
Installer. Once installed, the Installer starts.

e To install from the Cincom Smalltalk CD, insert the CD in a drive.
On many systems the Installer starts automatically. If it does not,
start it using the method appropriate to your platform:

2-1
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Installing VisualWorks

e Windows: Double-click on the installwin.bat script file.
* UNIX/Linux: Execute the installer shell script installUnix.

¢ Mac OS X: Double-click on the installMacOSX.command
file.

Upon startup, the Installer provides installation options.

+* Cincom Smalltalk Installer,

Cincom Smaltalk 0o® %000

Welcome to the Cincom Smalltalk Installer

This kool can either install or remove Cincom Smallealk from your computer, Cincom Smalltalk can be installed either from local
media, such as a COROM drive, or from Cincom's server, Select an option and click Next.

(%) Typical Install

Express install of the latest version of Cincom Smallcalk From Cincom's FTP server using kypical install options,

() Custom Instal

Choose which version and components of Cincom Smalltalk to install. All installation options may be customized,

() Uninstal

Remaove an existing installation of Cincom Smallcalk From this computer,

| Mexk = |l Cancel l

Select and follow the instructions for either a “Typical” Installation or
“Custom” Installation.

“Typical” Installation

2-2

The “Typical” installation option installs base VisualWorks and several
of the most commonly used extensions into a pre-determined
directory.

1 Select the Typical Install option click Next.

If the Installer finds a previous “typical” installation, it assumes
you wish to make changes or add components, as in a “custom”
install. Refer to “Custom” Installation.

Cincom Smalltalk
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2 The Installer displays a summary of the installation. Review the
summary and click Next to proceed.

£ .
«* Cincom Smalltalk Installer

L

- 4

. @

]
Gincom Smalltalk o ¢
Installation Options Summary

Installer is up ko date, ~
Install Visualwiorks Release 7.7

From F:lww?, Flimagelinstall. map

to Fi\Program Files\Cincom Systems, Incivw?. 7
28 of 49 components selected (574, 4Mb):

Advanced Tools  (1.0Mb)

Base Visualworks  (143,7Mb)

coM o (19.8ME)

Database (6.0Mb)

DLL & C Connect  {18.3Mb)

DST (Distributed Smallcalk) — {5.2Mb)

Glorp (4.0Mb)

Locale - Japanese  (0.5Mb)

Opentalk {3, 1Mb)

Plugin  {24.4Mb})

Preview {20.6Mb})

Foooide fad amaln

v

l < Back ” Install | l Cancel l

3 For non-commercial distributions, review the license agreement.
Select | Accept, and click Install.

The Installer shows progress as each component is copied to the
local disk of your workstation.

4  After all components have been installed, the Installer indicates
successful completion. Click Exit to finish.

This completes the installation.

For Mac OS X, Linus, and Unix installations an informational screen
is displayed with instructions for setting your UNIX system variables.
This information is also saved in the text file userActions. txt,
located in the install directory.
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“Custom” Installation

24

A custom installation allows you to choose the version of
VisualWorks to install, the target directory, and the specific
components you wish to install.

1 To begin, select Custom Install, and click Next.

2 On the following page, you may choose among the latest
available versions on Cincom’s web site by clicking on
Check Server. If you are installing from a CD, you may skip this
step.

% Cincom Smalltalk Installer

Cincom Smaltalk cs0%:0%0"

Check for Awvailable Downloads

Click Check Server to check Cincom's FTP server For additional versions of Cincom Smallkalk and updates For this Installer,
Mo information is collected by Cincom during this step,

Or, click Mext to proceed,

Check Server v pply Updat Cincom Smallealk Installer v1.4

l < Back ” MNexk = | l Cancel l

Once the Installer has finished scanning the web site, click on
Next.

Cincom Smalltalk
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3 Select a product and version to install and click Next.

£ .
+* Cincom Smalltalk Installer

Cincom Smaltalk no®% 0%

Install Cincom Smalltalk

Please select the product you wish to install and click Next.

Visualwiorks Release 7.7 v| | Cther...

Install from:
Filww 7, Flimagelinstall. map

[ <o J[ voe> | [ conn ]

All available products and versions are shown in the drop-down
list. Selecting one item causes the Installer to fetch additional
details (these may take a few seconds to display).
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4  Specify the installation directory and click Next.

£ .
«* Cincom Smalltalk Installer

Cincom Smaltalk -seeteed.

Installation Directory
Choose the installation directory,

Wisualworks Release 7.7 components will be installed in directory tree specified below, If the directory does not exist, it will be
created.

Installation Directary: Browse:

FiYProgram Files\Cincom Systems, Incivw? .7 |

l < Back ” Mexk = | l Cancel l

The directory shown as a default by the Installer is typical for the
platform you are installing.

If the default does not suit your needs, edit it or Browse... to select
the directory. If the specified directory does not exist (typically the
case for a new installation), it will be created for you.

If you have previous versions of VisualWorks installed, we
recommend installing into a new directory. This allows you to run
previous versions, and avoids conflicts from mixed versions of
component files.

Cincom Smalltalk




Running the VisualWorks Installer

5 Select the VisualWorks components you want to install.

% Cincom Smalltalk Installer

] °® .0
Gincom Smalttalk 0% 0° 508
Components to Install | select: vl|
~ fdvanced Tools 1.0Mb A
V' Base VisualWorks 118.5Mb
COM 16.7Mb
~ Database 5.2Mb
V' DLL & C Connect 19.3Mb
DotMET Connect 11.0Mb
~ [DST (Distributed Smalltalk) 5.0Mb =
Place shorkcut on desktop Space required: 599.2Mb
l < Back ” Mexk = | l Cancel l

By default, the components for a typical installation are pre-
selected. Clic on an item to select or deselect it. Select at least
the Base VisualWorks component and the VM (virtual machine)
component for your platform.

When you have made all your selections, click Next.
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Installing VisualWorks

6 Review the summary of installation options an click Next.

£ .
«* Cincom Smalltalk Installer

Cincom Smaltalk LAY

Installation Options Summary

Installer is up ko date, ~
Install Visualwiorks Release 7.7

From F:lww?, Flimagelinstall. map

to Fi\Program Files\Cincom Systems, Incivw?. 7
28 of 49 components selected (574, 4Mb):

Advanced Tools  (1.0Mb)

Base Visualworks  (143,7Mb)

coM o (19.8ME)

Database (6.0Mb)

DLL & C Connect  {18.3Mb)

DST (Distributed Smallcalk) — {5.2Mb)

Glorp (4.0Mb)

Locale - Japanese  (0.5Mb)

Opentalk {3, 1Mb)

Plugin  {24.4Mb})

Preview {20.6Mb})

Foooide fad amaln

v

l < Back ” Install | l Cancel l

7 For non-commercial distributions, review the license agreement.
Select | Accept, and click Install.

8 The Installer shows progress as each component is copied to the
local disk of your workstation:

9 After all components have been installed, the Installer indicates
successful completion. Click Exit to finish.

This completes the installation.

For Mac OS X, Linus, and Unix installations an informational screen
is displayed with instructions for setting your UNIX system variables.
This information is also saved in the text file userActions. txt,
located in the install directory.

Installing Additional VisualWorks Components
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After the initial VisualWorks installation, you can use the Installer
application again to install additional add-on components.
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Extracting VisualWorks from Downloaded Files

1 If you installed from the Cincom Smalltalk CD, load it in your
computer's CD-ROM drive.

2 Start the installer:
Windows: Go to Start > Programs > VisualWorks 7.7 > Install/Uninstall
UNIX: Execute the script vw7.7nc/Install_Uninstall

MacOS: Double-click on the installation image file
vw7.7nc:image:install.im

3 Once the Welcome screen appears, select Custom Install, follow
the initial steps as described in the previous section, clicking Next
until you reach the Components to Install screen.

4  Select the components you wish to add, and click Next.

5 When the installation is complete, click Close to exit.

Extracting VisualWorks from Downloaded Files

Advanced users may prefer t download and extract individual
components. The non-commercial release of VisualWorks 7.7 is
available as a collecton of compressed files downloadable from the
Cincom Smalltalk web site:

http://www.cincomsmalltalk.com/

From this web page, follow the download links for VisualWorks Non-
Commercial, and select to download individal files.

The compression format, .tar.gz, is common on UNIX platforms, but is
handled well by decompression utilities on other platforms as well.
(Note that the MacOS virtual machine is in another format, .sit, which
is common on that platform.)

*  On Unix and Linux systems, use the usual decompression tools.

*  On Windows platforms, use WinZip 7.0 or later, available from
http://www.winzip.com.

* On Mac OS X systems, use Dropstuff (5.5 or later) or Stufflt
Deluxe (5.5 or later), with Expander.

UNIX and Linux Installation

1 Create an installation directory called vw7.7nc in an appropriate
directory, for example /usr/local/vw7.7nc.

Installation Guide 2-9
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Download the compressed files to the installation directory.

The product is divided into several files, and you probably to not
need to download them all. You do need at least the VisualWorks
Base and a virtual machine file. The files are described on the
download page to guide your selection.

Change (cd) to installation directory, where you downloaded the
files.

Extract each file using these commands:

%gunzip <file_name>.tar.gz
Y%tar -xvf <file_name>.tar

All VisualWorks files are extracted into it in the correct directory
structure. Additional subdirectories are created as needed.

Configure your environment to set this variable:
VISUALWORKS - e.g., to the value: /usr/local/vw7.7nc

Set this in the appropriate startup file.

This completes the installation.

Windows Installation

On Windows 2000, you must have Power User permissions in order
to install software. User permission alone does not permit updating
the system registry.

1
2

Create an installation folder called vw7.7nc, e.g.: c:\vw7.7nc.
Download the compressed files to the installation folder.

The product is divided into several files, and you probably do not
need to download them all. You do need at least the VisualWorks
Base and a virtual machine (VM) file. The files are described on

the download page to guide your selection.

Start WinZip 7.0 or later.

Open Options > Configuration > Miscellaneous, and uncheck TAR file
smart CR/LF conversion.

Open the base VisualWorks downloaded file in WinZip.

You will be prompted, asking whether WinZip should decompress
the single file into a temporary folder and open it. Click Yes. The
temporary file is created in \windows\temp, and has the same file

Cincom Smalltalk
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Extracting VisualWorks from Downloaded Files

name except for having only a .tar extension. This file will be
deleted when WinZip exits.

WinZip then displays the contents of the .tar file.
Extract the contained files into the installation directory (vw7.7nc).

All VisualWorks files are extracted into it in the correct directory
structure. Additional subdirectories are created as required.

Repeat steps 3 and 4 for each of the other files as well, selecting
the same installation directory (e.g., c:\vw7.7nc) each time.

When you have extracted all of your downloaded files, the
VisualWorks files are all installed in their propoer locations. The
directory structure, viewed in the Windows Explorer, should look
something like this:

X

File Edit View Favorites Tools  Help o

O Back ~ () ? /- ) Search Elv

Address |13 Filww?, Flimage v . &
Folders x Mame Size | Type
=) ww?. 7 ~ @visualﬁ‘l.im 25,487 KB IMFile
) advanced visual.cha 1,299 KB CHA File
123 bin @ wvisual.im 17,183 KB IMFile
I3 com EDvisual.im.zip 6,704 KB WinZip Fil
[ contributed wisual,sou 14,274 KB SOUFile
) database
12 dilcc
1) doc
|2 DotMETConnect
1) dst
1) examples
12 glorp
1) help
1) icc
=inage |
I2) japanese

[+ ) messane:

Folders

L~

5 objects (Disk free space: 174 GE) 63.4 MEB 'j My Computer

That's all there is for installation. But now there is some Windows
configuring to make launching reasonably easy.

Explore the vw7.7nc\image directory, select an image file
(visual.im), and double-click on it.

The .im file type so far should have no association, so a prompter
opens asking for the executable.

Click Other... to open a file browser. Find and select visual.exe
(probably in ¢c:\vw7.7nc\bin\win), and click Open.
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9

(The visualworks.exe file is an alternative option, but really only
useful if you have multiple versions of VisualWorks installed. This
is described in the Application Developer’s Guide.)

Check the Always use this program... checkbox, and click OK.

VisualWorks is now installed, and you can launch it by double-clicking
on an image (.im) file in the Windows Explorer.

This completes the installation.

MacOS Installation

1
2

Create an installation folder called vw7.7nc.
Download the compressed file(s) to the installation folder.

Download at least the VisualWorks Base and a virtual machine
file. The others are optional. To guide your selection, the files are
described on the download page.

Start Dropstuff or Stufflt Deluxe with Expander.

Open the Expander Preferences and, in the Cross Platform options,
choose Never for Convert Text Files to Macintosh text format.

Extract each file. A separate vw7.7nc folder is created for each
file.

Move the contents of all vw7.7nc folders to a single folder (note
that you must select the contents of each folder, because MacOS
replaces folders rather than merging their contents).

Open the folder vw7.7nc/bin/macx and find the compressed
VisualWorks virtual machine, named vw7.7.sit. Extract this file
(using Stufflt) into the same directory.

This completes the installation.

Cincom Smalltalk
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Starting VisualWorks the First Time

With VisualWorks installed, you can now launch a VisualWorks
session.

Depending on your operating system, there may be several ways to
launch a session. For example, on Windows systems, a VisualWorks
launcher icon is added to your Start menu (in a folder under the
Programs item), or you can double-click on an image file to launch
using the file association feature, or you can run a command line in a
shortcut.

Under MS-Windows and Mac OS systems, the simplest way to
launch VisualWorks is by double-clicking on the file visual.im, located
in the image directory of your VisualWorks 7.7 installation.

Regardless of the operating system, however, the various ways to
start VisualWorks all do the same thing. The following describes how
to launch a VisualWorks session on any system. This information will
make it clear what to do to make any platform launcher features work
as well.

Launching from the Command Line

Installation Guide

To start VisualWorks, you run the object engine (also called the
virtual machine) with the image file passed as the

argument:object_engine image_file

On MS-Windows systems, the virtual machine name is visual.exe, and
on MacOS and Unix system it is simply visual. By default, the virtual
machine is installed in the bin/<platform> subdirectory of the root
VisualWorks installation directory.

The initial image file on all platforms is visual.im, (visualnc.im for non-
commercial) and is installed in the image subdirectory. The image is
exactly the same on all platforms. This file should be write-protected,
and you should never save over it. Instead, you will want to save one
or more “working” images and use those for your development work.

To launch VisualWorks the first time then, using this command line
interface, start by changing to the image subdirectory, and execute the
object engine with the image as argument. For example, on
Windows:

> cd c:\vw7.7nc\image\ > ..\bin\win\visual.exe visual.im

2-13
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and on a UNIX or Linux system:

$ cd /usr/local/vw7.7nc/image $ exec ../bin/linux86/visual visual.im

Note that the paths may be different on your system. This approach
makes the image directory the current directory for execution, so
images will be saved there by default.

On Mac OS X, you must use the open command:

user% open -a visual.app visual.im

On some platforms, there are several engines you can use, as
described in the Application Developer’s Guide. For development
work, it is recommended that you use the engines named
vw<platform>, such as vwnt.exe for Windows platforms, and vwlinux86
on Linux. Using these engines can make debugging easier in case of
an engine crash.

When successfully launched, the VisualWorks splash screen is
displayed, and then, the VisualWorks Launcher and a Workspace are
displayed.

+* VisualWorks f:\vw7. 7\imagelvisual

File System Browse Debug Tools Window Help

H @ 3¢ | g ON 0@ »N »‘D CED\' 2

visual.im created at September 18, 2009 8:53:48 AN

+* Workspace

Page Edit Smallkalk Options Help

= = I g P ¢
(E2) @ \:}D '-D ‘j £ B }‘\f\ ,/ﬁt

Workspace | Variables

Welcome to -

VisualWorks® Release 7.7 of September 18, Z]Jq
Copyright © 2009 - 1999 Cincom Systems, Inc. All Rights Reserved

Please visit www.cincomsmalltalk.com for the latest release information.
v

Text or Smalltalk code " Al
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Set VisualWorks Home Directory

Save Image

Installation Guide

In order to correctly find additional files, the VisualWorks Home
directory must be properly set. Select File > Set VisualWorks Home in the
Launcher window. A Settings window opens, as follows:

&= Settings g@@
<> Look and Feel @ System
=R e BSystem veuaiorke home directors:
,ﬂ‘r, LOading IsUalvwar] 0me directory:

- Memory Policy Fi\Program FilesiCincom Systems, Inclww?, 7

~(2 Message Catalogs

Paste Current

(D Parcel Path
This is the default location of the VisualWorks home
® Time Zones directory, $(VISUALWORKS), which is used to find many of
- Transcript the systemfiles, such as parcelsthat can be loaded or
£ Tools systern source code.

-0 Browser
ik Debugger Supply the name of the main directory, of which "image”,
&j Formatter "parcels”, and "bin" are sub-directories. On Windows, this
- Warnings value is stored in the system registry, and you should not
| Workspace need to setitagain. On all other platformes, the location is

&L URI stored in an environment variable. On UNIX, the value is

setonly for the current session in VisualWorks.

I OK l ’ Caniel ]

Set the VisualWorks Home Directory to the root VisualWorks installation
directory, typically ¢c:\vw7.7nc on Windows systems or /usr/local/
vw7.7nc on UNIX or Linux systems. Then click OK.

On Windows systems, the VisualWorks Home is saved in the system
registry. On UNIX and Linux systems, it needs to be set in a system
variable, as described in an information screen at the end of the
installation (and in the file userActions.txt).

Now, before doing any other work, save a working image. This will be
the image you use to save your work, leaving visual.im unchanged.
Select File > Save Image As... in the Launcher to display the Save Image
dialog:
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Enter name for image file: EJ@
Savein: | |) image v €] ¥ ® -

Y @ wisualgd.im

:3 @ wisual.im

My Recent
Documents

Desklop

My Documents

9

My Computer

"} File name: wworking hd
by Metwork, Save as type: Image file [*.im) w

You should save this image in a personal working file area, rather
than in the installation file structure. The typical areas are:

Windows: Documents and Settings\My Documents\VisualWorks\
MacOS: Documents:VisualWorks:
Unix/Linux: $HOME/VisualWorks/

Create the appropriate directory then open it before saving the
image.

Enter a name for your working image, such as working, and click OK.
This will save the image as working.im and create a working.cha file
also (see the Application Developer’s Guide for further discussion of
these files). Do notinclude either extension (.im or .cha) when
specifying the file name in this dialog.

Since we launched VisualWorks with image as the current directory,
working.im and working.cha will be saved into that directory. For
another directory, specify either a relative or absolute path.

You are now ready to start working with VisualWorks. Additional
setup suggestions are provided below, but the essential setup is now
complete.
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Starting VisualWorks the First Time

Loading Parcels

Installation Guide

VisualWorks is divided into separate parcels, which are external
Smalltalk binary and source code components (also known as
packages). By selectively loading and unloading parcels, you can
control the size of the image, adding only the functionality you need.
Loading parcels is much faster than loading and compiling Smalltalk
source code.

To load a parcel/component that has already been installed by the
Cincom Smalltalk Installer:

1  Start VisualWorks, and open the Parcel Manager (click on System
> Parcel Manager in the Launcher):

+= Parcel Ma nager. g@g|

File Parcel Help
B & 28

4| Suggestions | Directories | Loadey ¥ | | Alphabetical | Prerequisite Tree

= ~| () RBCodeHighlighting [7.7 - 4] -~
|_J Browser Extensions (0 RBSUnitExtensions [7.7 - 1]

|_J Code Editing (J) RBTabbedToolsets [7.7 - 2]

1 Database ) SearchlightTools [222]

5 Deploying Appliations
1 Developer Tools ) SUnitToo(ls) [7.7 - 110]

| Distributed Computing @ UlPainter [7.7 - 12] hd

1 Graphics and Ul

Comment | Properties
1 Japanese Locale

(1 Networking © 2000 - 2008 Bruce Badger. Licensed under the LGPL. ~
|1 OS-Windows

_1 Other Libraries This package allows you to use PostgreSQL with StORE.

|1 Platform Connectivity

|1 Security For details on setting up and using a PostgreSQL StORE reporitory,

[ Testing please visit:

J Toys http:/iwiki.cs.uiuc.edu/VisualWorks/PostgreSQL+Libraries

| Version Control and

1 Web Development G G

LW ah Cansicac

Unsupported Goodie {not loaded): F:\Program FilesiCincom Systems, Inclww?, Ficontributed\PostgreSqLyStoreForPostgreSoL. pel

2 Browse the categories (folders) of parcels under the Suggestions
tab, especially the Essentials and Developer Tools categories.

VisualWorks has default parcel paths for many add-on products,
but if the path for the product you are installing is either not set, or
is set incorrectly, the parcel will not appear in the parcel list. In
this case, an additional path needs to be added.

To add or correct the parcel path for the product you are
installing, use the Parcel Path page in the Settings Tool (System >
Settings).
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3 Toload a parcel in the Parcel Manager, select the desired parcel
and then pick Parcel > Load.

A dialog may open, explaining that additional code may be
loaded. Typically you should click the yes to all button to continue.

Additional configuration may be required by add-on products. If so,
instructions are provided in the configuration or installation
instructions for that product.

Each parcel file (.pcl) has an associated source file (.pst) that holds
the source for all the code in the parcel. Both files are effectively
binary and must not be altered except by the parcel publishing
mechanism. If you extract parcels from an archive (zip) format, you
should disable any conversion options provided by your archiver. For
example, if you use WinZip, turn-off Tar file smart CR/LF conversion.
Failure to do so will result in errors when trying to browse the source
for a parcel within VisualWorks.

Setting Up a Network Environment

2-18

The section Starting VisualWorks the First Time (above) includes
instructions for configuring a stand-alone, single-user environment. In
a networked environment there are additional considerations. The
following recommendations are targeted at this networked style of
configuration.

Here is a recommended setup:
1 Make all the original installation files and directories read-only.

While this is a good idea in a single-user environment as well, it
is especially important in multi-user environments. Allowing
several developers to write to the same files will cause serious
data corruption errors.

2 Each user creates directories for their own images and parcels.

Typically, this will be on the users’ local drives or in their private
working area of a network drive. For example:

On Windows:

c:\vwwork\myimages
c:\vwwork\myparcels

Cincom Smalltalk



Installation Guide

Setting Up a Network Environment

On UNIX/Linux

<yourhome>/myimages
<yourhome>/myparcels

Set up a launcher mechanism (e.g., shortcuts on Windows, or
execution scripts on UNIX) to run the shared virtual machine, but
with the programmer’s personal image directory as the “current”
directory.

For example, in a Windows shortcut, specify the user’s personal
image directory as the Start in: directory. On UNIX systems, a
startup command file can be created in the user’s bin/ directory
which can be executed while the personal image directory is
“current,” but invoking the shared object engine. (Examples of
both of these setups are included by the installer.) Refer to the
VisualWorksApplication Developers Guidee for more setup
details.

Start VisualWorks on the original image (visual.im ), and open the
Settings Tool (System > Settings). On the Parcel Path page, add
your parcels directory (created in step 2).

This will include the user’s personal working parcels in lists of
parcels available for loading. You can drag the new name to the
top of the list to have it searched first.

Select File > Save Image As... in the Visual Launcher, and save a
working image.

Enter a name for the image, such as working, including path
information to your own image directory (step 2).

Because the original image is a read-only (step 1) file, you will
not be able to save over it.

When saving a parcel, programmers specify the path to their
personal parcels directory.

Specifying a relative pathname, especially one relative to the
VisualWorks home directory, facilitates moving the image to other
platforms. The directory path specified is remembered and
proposed as the path in subsequent saves of that parcel.

When starting VisualWorks, make the directory containing your
image file the current directory before launching VisualWorks.
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Uninstalling Products
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The VisualWorks Installer comes with an uninstall option. To use it:

1

Windows: From the Start menu, select Programs > VisualWorks 7.7nc
> Install/Uninstall.

UNIX: Execute the script ~vw7.7nc:/Install_Uninstall.
MacOS: Double-click ~vw7.7nc:image:install.im

On the Install or Uninstall page of the Installer, select Uninstall and
click Next.

The Installer will display all VisualWorks installations in the drop-
down menu. Select the product you wish to uninstall and click
Next.

The Uninstaller will prompt you for the disposition of various

aspects of the VisualWorks installation, such as whether you
want to delete non-empty directories. Answer these prompts
accordingly.

When the Uninstaller is finished, you may need to manually
remove files and/or directories, such as directories containing
files that you created using VisualWorks.

Cincom Smalltalk
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Installing ObjectStudio 8

The procedures described in this section install ObjectStudio 8.2
from the Cincom Smalltalk DVD.

The installation is performed using InstallShield, which sets up the
required directory structure on the specified disk drive and copies the
ObjectStudio files into that structure. Instructions are displayed by the
installer as responses are needed.

Running the Installer

The installer launches when you mount the ObjectStudio 8.2 DVD.
Alternatively, you can execute the ObjectStudio installer directly from
the DVD by running \ostudio\disk1\SETUP.EXE.

The installation proceeds through several pages of instructions,
collecting installation parameters. Once the information is gathered,
the necessary directories are created and the ObjectStudio files are
copied into them.

Because the installation involves installing a few Windows DLL files,
the installation recommends that you close all other applications
during the installation.

Installation Guide 3-1



Installing ObjectStudio 8

Installation Options

Components

Several components are optional. By default, all are selected for
installation. You can deselect components that you do not expect to
use.

Brief descriptions of the components are provided in the installer. For
full descriptions, refer to the ObjectStudio documentation after
completing the installation.

You can install any components later by rerunning the installer.

Program Group Options
You have the choice of installing ObjectStudio in either:

e Common program group, which makes ObjectStudio available to
all users of this computer, or

* Personal Program group, which makes ObjectStudio available to
the currently logged in user only.
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Thank You...

Installation Guide

... for installing and trying Cincom Smalltalk. We hope, and expect,
that you will find this to be an enjoyable and productive development
environment.

There are a variety of resources available to help you become
productive with VisualWorks and ObjectStudio. Complete
documentation is provided for both products. The VisualWorks Walk
Through provides a simple overview of building an application in
VisualWorks.

A variety of web sites also provide information for VisualWorks
developers. Visit the Cincom Smalltalk Wiki:

http://www.cincomsmalltalk.com
for information and additional links.
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